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About this Practice Workbook... 

• The Module 6 - Initial Corridor Modeling.zip file will be provided for download. 

• Extract the zip file to the root C:\ 

• All files are then automatically extracted here:  
C:\NCDOT Training\Roadway\Module 6 - Initial Corridor Modeling 

 

• Module 6 - Initial Corridor Modeling PDF will also be located here. 
 

• This PDF file includes bookmarks providing an overview of the document. Click on the 
bookmark to quickly jump to any section in the file. You may have to turn on the bookmark 
function in your PDF viewer, such as Adobe Reader. 

 

• The dataset used throughout this module uses English units and US Survey Feet. 
 

• Each module in this series is self-contained. You can jump to any section and begin the 
exercises. 

 

• The NCDOT_WorkSets.inp on your desktop should be set to the following variables: 

o NCDOT_USE_LOCAL_WORKSETS = L2 
o NCDOT_UNIT_TRAINING_WORKSETS = Roadway 

• This training module uses the DOT-US North Carolina WorkSpace, R-2635C (Training)  
WorkSet and NCDOT_Roadway Role. It is very important that you select the correct 
WorkSpace, WorkSet and Role.  

• The color of the Curb ang Gutter and Monolithic Island changed from red to blue during the 
workbook creation. Screen shot color in this workbook is different from the WorkSpace. 
 
  

• This workbook was written with the release of OpenRoads Designer 10.10.XX.XX  (2021) 
OpenRoads Designer 2021 R2  
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Overview 
 
The intent of Initial Corridor Modeling is to “push” a template along a corridor to draw the base 
design elements into a 2D model for plan production while also producing a basic 3D model within 
the same dgn file. Corridor tools are accessed by selecting the Corridor Ribbon as shown below. 
 

Corridor Ribbon 

 

OpenRoads Designer Corridor Modeling Workflow  
 
OpenRoads Corridor Modeling workflow is summarized below. 
 

1. Create mainline CMD file using the provided NCDOT 2D Design seed file  
2. Attach the existing terrain model (ETM) & the proposed geometry file (ALG) 
3. Set the existing terrain model to be the active terrain 
4. Develop and/or define templates for project 
5. Create a corridor using the Horizontal and Vertical geometry that resides in the ALG file 
6. Add template drop(s) based on project corridor specific typical sections 
7. Make additional adjustments to your template(s) points based on project specific needs. 

These changes can be made using parametric constraints, point controls, and feature 
constraints. (optional) 

8. Assign superelevation information to your project corridor (optional) 
9. Process corridor  
10. Review corridor in 2D,3D and Dynamic Cross-Section views and make any necessary revision 

 
Notes: 
This is a brief summary for a general workflow and is for informational purposes only. The exercise 
that follows provides more detail and is specific to the Initial Corridor Modeling Training. 
 
NCDOT recommends a maximum Corridor length of 1.5 miles. For larger projects, it may be necessary 
to break the project corridors up in order to accommodate this recommendation. 
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Corridor File Summary 
 
Each Corridor DGN (CMD) file consists of both 2D and 3D views within a single DGN file. The 3D view 
includes all elements that have a vertical elevation associated with it. The user will be working 
exclusively in 2D to produce a Three-Dimensional model. The 2D view could be described as an 
interface used to develop and edit a 3D model. Once the corridor/3D model has been processed, 2D 
linework is generated as a by-product of the model itself and can be used for plans production. The 
2D view and 3D model are co-dependent of one another.  
 

Templates Summary 
 
A template is fundamentally a typical section that is “pushed” along an alignment to create a 
proposed 3D model as well as 2D base design elements required to produce a set of plans. An 
example of an NCDOT template for a 2-lane undivided facility with shoulders is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Templates are stored in a template library (.itl) file and are made up of points, components, and  
end conditions. Generally, you will be working with a few template libraries at any given time: a 
workset template as well as a standards template library. The standards template library or libraries 
may contain pre-configured templates and/or components for building templates which can be 
copied from the standards library to the project specific workset template library as needed.  
 
 



 

Module 6 – Initial Corridor Modeling 
 

 
 

Page | 7  
 
 

Standard NCDOT Corridor template library locations are shown below: 

• Standard NCDOT Roadway Corridor Template Libraries are contained in the following folder: 
…\Configuration\Organization-Civil\Disciplines\NCDOT_Roadway\Standards\Template Library 

• The Workset Template Library should be stored in the same folder as the CMD file itself. 
…\Roadway\Design 

 

Corridor Ribbon Summary 
 
The Corridor Modeling toolset is a group of highly interactive commands to create new design 
surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 
management, and report functions are supported. The Corridor Ribbon tab is broken up into seven 
(7) groups.  
 

Primary & Selection 
These two (2) groups are displayed throughout the ribbon, irrespective of which tab is selected. 

The Primary group is a launch point for commonly used tools and the Selection group is used to 
select and deselect elements for modification or manipulation. 
 

Create 

The Create group is used when starting a corridor design and includes tools for creating corridors, 
template drops, and transitions, along with various tools for working with the template library.  
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Edit 

The Edit group contains tools for editing a previously created corridor and associated template drops. 
These tools enable the user to refine the model by adding more detailed information to respond to 
project-specific requirements and constraints. The Corridor Objects dialog can be accessed here 
which can be used to manage all corridor objects from one location. 
 

Miscellaneous 

The Miscellaneous group contains additional tools meant for corridor manipulation.  
 

Superelevation 

The Superelevation group contains tools for creating, calculating, and editing superelevation lanes. 
Tools are also supported for importing CSV data and reporting. 
 

Review 

The Review group contains tools used to analyze and report on corridors/3D models. The Dynamic 
Sections tools will be used extensively throughout the life of a corridor. The models cross section 
view is accessed here. 
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Corridor Objects Dialog Summary 
 
The Corridor Objects dialog is a summary of all corridor modeling objects and provides an efficient 

method of managing data. Clicking on the various categories located on the left side of the dialog 

displays the appropriate data in the center section. Clicking on a single line in any display places the 

information to the layout at the right side of the dialog, where much of the information may be 

edited. The Corridor Objects dialog can be accessed from the ribbon (Corridors > Edit > Corridor 

Objects). 

Feature Definition Summary 
 
Feature Definitions are used to control symbology, annotation, and various other properties that are 

applied to the geometric elements.  

• Define what the geometric elements actually are. What is being modeled such as curb, 
centerline, edge of pavement, etc. 

• Control symbology in various views, including capability to define differing symbology in plan, 
profile, and 3D spaces 

• Define surface display characteristics 

• Define terrain modeling attributes (spot, break line, void, etcetera)  
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Initial Corridor Modeling Exercise 
 
In this exercise, you will learn how to create a corridor using pre-defined horizontal and vertical 
geometry. You will learn how to create/review/edit a corridor, assign template drops, use parametric 
constraints, and access the dynamic cross section view of your corridor. You will also be introduced 
to the corridor objects dialog. Throughout this exercise, all design and corridor manipulation will be 
performed exclusively within an NCDOT 2D dgn file.  
 
1. Launch OpenRoads Designer CONNECT Edition 
             Double-click on the NCDOT Roadway OpenRoads icon on your desktop to launch 
             OpenRoads Designer into the NCDOT Roadway workspace. 
 
2. Set the Workspace and Workset 
             Select DOT-US North Carolina from the Workspace menu. 
             Select NCDOT R-2635C (Training) from the Workset menu. 

 
 
 
 
 
 

3. Open the Y11 Corridor (CMD) dgn file 
Click the browse button and path to the C:\NCDOT Training\Roadway\Module 6 - Initial 

Corridor Modeling\Roadway\Design\ Module 6 (Initial Corridor Modeling) folder and 
open the R-2635C_RDY_CMD_Y11.dgn file. 
 

4. Attach Files required for Modeling the Y11 Corridor 
A. Click the References button (Corridors > Primary > References) and the  

references dialog will open. 
B. Attach the following dgn files to your Corridor (CMD) file using the references  

dialog: 
• …NCDOT Training\Roadway\Module 6 - Initial Corridor Modeling\Final Survey\ 

R-2635C_RDY_ETM.dgn 
• …NCDOT Training\Roadway\Module 6 - Initial Corridor Modeling\Roadway\  

Alignment\R-2635C_RDY_ALG.dgn  

 
 
 

 
 

… 
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5. Set the Existing Terrain Model to be the Active Terrain 
A. Zoom-in near the Y11 alignment as shown below.  
B. Click on the existing terrain boundary (shown in blue below) and hover for a few moments.  

Notice that a context menu with three (3) tool icons is displayed.    
C. Move your mouse over the Active icon tool and notice the display reads Set As Active 

Terrain Model.  
D. Click the Active icon tool and your existing terrain has now been set to the active terrain. 

(Note: this action can also be performed from the Terrain tab in the ribbon) 
 

 
 

 
 
 

 
 
 
 
 
 
 

 

Y11 
  ALIGNMENT 

SET AS ACTIVE 
TERRAIN MODEL 
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E. Click the References button (Corridors > Primary > References) and the  
References dialog will open as shown below. 

F. A new model called Default-3D has been created and automatically attached as a 
reference file to the default 2D model. This occurs when an existing terrain 
model is set to active. 

 
 

 
 

G. All elements that have an associated vertical property will now be visible in both the Default 
model and the Default-3D model. These elements will also be displayed in the default 2D 
view as well because the Default-3D model is attached. As you design in 2D, toggling the 
Default-3D model on and off using the References dialog can be very helpful to clean up the 
view.  
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6. Set up Workset Template Library  
A. Click the Create Template button (Corridors > Create > Template > Create 

Template).  
B. The Create Template dialog will open. A workset template library will load by 

default if one exists. If one does not exist, the NCDOT_RDY_Standard_Templates.itl will 
be loaded instead. In our case, a workset template library does not exist and will 
need to be created. 

 
Note: The workset template library must follow the standard NCDOT naming convention and 
must be located within the workset template library folder as defined by NCDOT. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

C. From the Create Template dialog shown above, click (File > New > Template Library) and 
path to the C:\NCDOT Training\Roadway\Module 6 - Initial Corridor Modeling\Roadway \Design folder. 
Type NCDOT_Roadway_R-2635C (Training).itl in the file name dialog. You have now created the 
workset template library for this module. This workset template library will now be loaded by 
default, the next time the workset is loaded.  

 

RED BOX INDICATING 
THE ACTIVE TEMPLATE 
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D. From the Create Template dialog, click (File > New > Folder) and create a Project Templates 
folder. Project specific templates should be stored and managed from this folder.  

E. Module 5 will be focused on the -Y11- alignment and require two (2) templates. The 
 UF - 1+1 Lanes - LDSS template and the TMPLT- Bridge Dual Lane template. Both can be copied from 

the NCDOT_RDY_Standard_Templates.itl using the Template Library Organizer. The Template 
Library Organizer can be accessed by clicking (Tools > Template Library Organizer) from the 
Create Template dialog menu. 

 
Note: 
The Template Library Organizer is a tool that allows the user to copy templates from one 
template library to another. The Template Library to be Copied From is displayed on the 
right-hand side of the dialog, while the Active Template Library on the left-hand side of the 
dialog is the Library that the template will be copied to.    
 

F. Once the Template Library Organizer dialog opens, click the Browse button as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

BROWSE 
BUTTON 

ACTIVE 
TEMPLATE 

LIBRARY 
 

TEMPLATE 
LIBRARY TO BE 
COPIED FROM 
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G. Next, path to the C:\MICROSTATION_CONNECT_WORKSPACE\Configuration\Organization-

Civil\Disciplines\NCDOT_Roadway\Standards\Template Library folder and select the 
NCDOT_RDY_Standard_Templates.itl file and click the OPEN button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice that the NCDOT_RDY_Standard_Templates.itl folder structure is now visible in the preview pane on 
the right-hand side of the dialog. 

 
 
 

 

ACTIVE 
TEMPLATE 

LIBRARY 
 

TEMPLATE 
LIBRARY TO BE 
COPIED FROM 
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H. Next, expand the Road-Rural (Undivided Shoulder) folder and then drag and drop the 
UF - 1+1 Lanes - LDSS template from the right-hand side of the dialog to the Project Templates 

folder under the Active Template Library on the left-hand side of the dialog. 
I. Finally, copy the TMPLT- Bridge Undivided 1+1 template from the Bridge (Preliminary) folder to the 

Project Templates folder and click the OK button. When prompted to save data, select Yes. 
 

7. Rename Project Templates to Coordinate with Y11 Corridor 
A. Rename the UF - 1+1 Lanes – LDSS template to Y11_UF - 1+1 Lanes – LDSS template.  

B. Rename the TMPLT- Bridge Undivided 1+1 Template to Y11_TMPLT- Bridge Undivided 1+1. 
 
Note: The workset template naming convention should be discussed and agreed upon by the project team. 

 
8. Review Project Template(s) 

A. Double click on the Y11_UF - 1+1 Lanes – LDSS template under the Project Templates folder to 
make it active in the Create Template dialog box and then maximize the window to better 
examine it.  

B. For this part of the exercise, you will be examining the (+ETO) point which is used to control 
the right-side edge of travel. To review the point properties, you must access the Point 
Properties dialog. This can be done by right-clicking on the point and selecting Edit from the 
dropdown or by simply double-clicking the point.   

 
 

 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

+ETO 
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C. After double-clicking the +ETO point, the Point Properties dialog will open as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Two (2) template attributes that should be noted and considered throughout the entire 
modeling process are as follows: 

• Parametric Constraints – redefinable variables that use the Label property defined on a 
points constraints to override the defined (default) value over a specified station range 
using the Corridor Objects dialog (Corridor Objects dialog will be covered in detail later in 
this exercise) 

• Horizontal Feature Constraints – overrides the point constraints if a feature or alignment 
with a matching feature is found within a specified horizontal range 
 

Both Constraints are used to define template point properties and can be accessed through 
the Point Properties dialog as shown above.  

 
 

PARAMETRIC 
CONSTRAINT 

HORIZONTAL 
FEATURE 

CONSTRAINT 
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E. Notice the Constraint 1 properties of the +ETO point shown below.  
 

• Constraint 1 Type: = Horizontal 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
The Type property defines how a point is constrained. 

 

• Constraint 1 Parent 1: = CL 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
The Parent 1 property defines the parent point of a constraint. Notice the Target icon to 
the right of the CL point. This indicates that a point can either be selected using the 
provided drop-down or directly from the template with a simple mouse click within the 
Template library. 
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• Constraint 1 Value: = 12.0000 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Value property defines the default numeric value of the +ETO point as it relates 
to the Parent 1 (CL) point. In the example above this would indicate the +ETO point is 
12’ to the right of the CL point. This default value can be redefined as needed per 
project specifications. 

 

• Constraint 1 Label: = LN_Width 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

The Label property defines the name of the +ETO point’s Parametric Constraint. In the 
example above the value is set to LN_Width . This represents the name of a redefinable 
template variable that can quickly be changed as needed after the template has been 
applied to a corridor. This allows the user to override a default template value during 
design without having to modify the template itself. 
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F. Notice the Horizontal Feature Constraint checkbox for the +ETO point shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When the Horizontal Feature Constraint checkbox is marked, the template will search 
the corridor file for a pre-defined horizontal feature that is selected from the dropdown 
to the right. If that feature is located, the default horizontal point value will be ignored 
and follow the feature instead. In this instance the Horizontal Feature Constraint is 
CCE_Target_EOT_Out_RT. The Range value represents the horizontal distance that the 
template will search when looking for the defined Horizontal Feature Constraint. In this 
instance, notice that the Range value is set to 0.0000. This value equates to an infinite search 
range.  
 

G. Close the +ETO’s Point Properties dialog but keep the Create Template dialog open. 
 

H. Template properties can also be accessed easily by selecting the Active Template tab. The 
template properties listed under the Active Template tab comprise information on every 
aspect of the active template including Parametric Constraints and Template Points. The 
Active Template tab is located near the bottom left corner of the Create template dialog as 
shown below. 
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I. Click the +ETO Point shown within the Active Template window and notice the +ETO Point is 
then highlighted blue in the Create Template dialog to the right.  

 

 

 
  

+ETO Point 

Active Template 

+ETO Point 
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9. Create a Corridor using the Y11 Baseline 
A. Click the New Corridor button (Corridors > Create > New Corridor). Notice the 

heads-up prompt displays Locate Corridor Baseline. A tool settings dialog box that 
corresponds with the heads-up prompt will also be visible. If you choose to provide 
information using the dialog box, the heads-up display will reflect your choices.  

 
 
  

 
 
 
 
 
 
 
 
 

Y11 
  ALIGNMENT 
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B. From the Create Corridor dialog box click on the Feature Definition dropdown as shown 
below. Notice the different feature definition options under the NCDOT folder. These are 
called Design Stage features. A Design Stage feature is selected when first creating a corridor 
and should be changed as the design progresses from Conceptual to Final design. Design 
staging helps to optimize a computers processing power by setting the level of detail a 
corridor requires per design stage. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Corridor Feature Definition (formerly called Design Stage) 
 

• Conceptual – “5” Corridor Template Drop Interval x “20” Multiplier = 100’ Interval (Green) 

• Design – A50 – “5” Corridor Template Drop Interval x “10” Multiplier = 50’ Interval (Yellow) 

• Design – B25 – “5” Corridor Template Drop Interval x “5” Multiplier = 25’ Interval (Yellow) 

• Final – “5” Corridor Template Drop Interval x “1” Multiplier = 5’ Interval (Red) 
 
When used properly, the Corridor Feature Definition determines the increment distances in the 
Dynamic Cross Section View. 
 

C. Set the Create Corridor dialog parameters as follows: 

• Feature Definition = Design - A50 (Corridor > NCDOT > Design - A50) 

• Name = Y11 
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D. As directed by the prompt, click the Y11 alignment. Notice the heads-up prompt now displays 
Locate Profile-Reset For Active Profile.  

E. In this instance, right-click Reset to use the Y11 active profile.  
F. The heads-up display will now prompt you to select a template. Hold Alt+Down arrow or click 

the three dots to the right to browse to the Project Templates folder you created previously and 
choose the Y11_UF - 1+1 Lanes – LDSS template as shown below. 

 

G. You will now be prompted for a start station. Notice as you move your cursor back and 
forth the station parameter changes based on the Y11 stationing. You can either left-click 
to accept the station parameter as displayed in the prompt, key-in the start station, or hit 
the ALT key to lock to the start of the Y11 alignment. In this instance, hit the ALT Key. This 
will lock the start station to the beginning of the Y11 alignment.  

H. Next you will be prompted for an end station. This time key-in 19+35.00 which will be the 
starting point for the Y11 Bridge Corridor. 

I. Finally, key-in 10.000 when prompted for a drop interval.  
J. Notice the Create Template Drop dialog parameters are now set as follows: 

• Start = 10+00.00 

• End = 19+35.00 

• Drop Interval = 5.0000 

• Template = Y11_UF - 1 + 1 Lanes - LDSS 
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K. A corridor called Y11 has now been created and is visible on screen in the default 2D 
model/view as shown below. 
 

 
 
 
 

 
 
 
 
 

 
 

L. Because OpenRoads Designer recognizes when a corridor does not match the station limits of 
an associated alignment, you will be prompted for an additional template drop. In this 
situation an additional template drop is necessary, so key the following parameters into the 
Create Template Drop dialog: 

• Start = 22+00.00 

• End = End of Alignment (Alt to lock to ending station) 

• Drop Interval = 5.0000 

• Template = Y11_UF - 1 + 1 Lanes - LDSS  
 

Note: 

• In a scenario where there is no need for additional template drops simply 
right click to end the prompting.  

• The Create Template Drop dialog can also be accessed from the ribbon 
(Corridors > Create > New Template Drop). 

• A “Blank” template may be used as a placeholder in the area where the 
preliminary bridge is to be located. 
 

M. The Y11 corridor has been updated and is now broken from 19+35.00 thru 22+00.00 as 
displayed below. The corridor has been broken in this range to accommodate a bridge 
corridor that will be included later in this exercise. 

Y11 
  CORRIDOR 

TEMPLATE 
DROP 1 
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CORRIDOR 
OBJECT 
HANDLE 

CORRIDOR 
OBJECT 

 
10. Review Corridor Object and Template Drops  

A. in the View 1-Default window, zoom in closely to your corridor. Hover your curser over the 
Y11 corridor and notice that the entire corridor displays pink. The pink highlight represents 
what is called the Corridor Object. The Corridor Object includes handles that are used to 
access a menu of common corridor commands. 

 
 

 
 
 
 
 
 
 
 
 
 

B. Click on one of the Corridor Object Handles (tick mark) and hover for a few moments to 
display the Corridor Menu as shown in Step 10A. 

Y11 
  CORRIDOR 

TEMPLATE 
DROP 1 

TEMPLATE 
DROP 2 
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C. In addition to the Corridor Object, notice the two (2) closed shapes that run along the 
corridor. These represents the two (2) Template Drops and include Template Drop Handles 
at the beginning and end of each. 

 
D. Click on any of the Template Drop Handles and notice that directional arrows and stationing 

are displayed at the beginning and end of the Template Drop. Hover over the handle for a 
few moments after clicking and a Template Drop Menu will appear. This menu includes 
common template tools. 

 
 
 
 
 
 
 
 

 
 
 

 
E. Next, click one of the Template Drop Handle Arrows and move your cursor back and forth.  

Notice that the corridor can be updated dynamically by adjusting the handle location. 
F. Right-click to release the Template Drop Handle Arrow. 

 
  

68+67.72 

22+00.0
0 

TEMPLATE 
DROP 2 

TEMPLATE 
DROP 

HANDLE 

TEMPLATE 
DROP 1 
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22+00.0
0 

22+00.0
0 

11. Use a Key-in to Adjust the Corridor End Station 
A. Stationing can also easily be changed with a key-in. Simply click on the Template Drop end 

station text that currently reads 34+33.17 and notice that a station input box is now displayed 
as well.  

B. Key 33+56.00 into the input box and then hit enter.  
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

C. The Y11 corridor and Template Drop have now been dynamically updated and have an end 
station of 33+56.00. 
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12. Use the Corridor Objects Dialog (the “bucket”) to Edit the Corridor 
Start Station 
A. Click the Corridor Objects (“The Bucket”) button located within the 

Edit group on the Corridor tab. Notice that the heads-up prompt 
displays Locate Corridor. 

B. As directed by the prompt, click the Y11 Corridor and the Corridor 
Objects dialog will load as shown below. 

 
C. Keeping focus on the Template Drop row, select the first template drop at the top of the list, 

Notice the Template Drop properties are displayed to the right. 

 
D. Under the Station Range Category change the Start Station from 10+00.00 to 10+25.00 as 

shown below. 
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22+00.0
0 

E. Close the Corridor Objects dialog and notice that the Y11 corridor has been updated to begin 
at station 10+25.00 as shown below. 
 
 
 

 
 
 
 
 
 
 
 
 
 

13. Use View Tools to Examine the Y11 Corridor in 3D 
A. Up until this point you have been working exclusively in a Two-Dimensional view. As 

described earlier in this document, you will always design and manipulate your model in  
2D. However, it is very important to review your model in 3D using a Three-Dimensional 
view. 

B. In the top left corner of your window, notice the text that reads View 1, Default. This 
represents the view’s description. As additional views are opened throughout the 
design/modeling process, this information will be visible in the same location per view. 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VIEW  
DESCRIPTION 

LOCATION 
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C. Multiple views and view combinations can be quickly accessed using the the OpenRoads 
Designer View Control tools. To access these tools, right-click and hold for a few moments 
anywhere within the View 1, Default window and a context menu will appear. The context 
menu contains a number of helpful quick access tools including a View Control menu shown 
at the top of the list. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
D. From the View Control tools sub-menu, select the 2 Views Plan/3D option. Notice the 

number prefix for each of the view options listed. This number represents how many views 
will be opened when selected. In addition to the number prefix, each view option also 
includes a brief description. The prefix and description of the 2 Views Plan/3D option 
selected indicate that two (2) views will open: the plan (2D) view as well as a 3D view.   
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E. Notice that your screen has split into two (2) separate views as shown below. There is now an 
additional view to the right of the original View 1, Default view. Notice the View Description 
of the additional view on the right reads View 2, Default-3D. 

 

 
 

F. Notice the View 2 View Description includes the suffix “-3D” because it’s a 3D view. This is a 
quick and easy method to determine if a view is three-dimensional or not. If the suffix “-3D” 
acronym is not included in the View Description, it would indicate a 2D view. 

 
 
 
 
 
 
 
 

VIEW 1, 
DEFAULT  

VIEW 2, 
DEFAULT-3D 
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G. Zoom in closely to the Y11 corridor in the View 2, Default-3D window and select Rotate 
View from the View Rotation menu located at the top left corner of the View 2, Default-3D 
window.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

H. Notice that the Rotate View dialog box displays. From the Rotate View dialog, select Dynamic 
from the Method dropdown menu.  
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I. After selecting the Dynamic Method from the Rotate View dropdown, using the left mouse 
button, click and hold near the Y11 corridor in the View 2, Default-3D window.  

J. Continue holding the button down and slowly move your mouse in a circular motion.  As you 
move your mouse, notice that the Y11 corridor is rotating in 3D.  

K. Spend a few moments examining the Y11 corridor and how it reacts to the movements of 
your mouse. Try zooming in and out and then repeating the rotation commands. Tentative 
snapping to an object will allow rotation and zooming focused on the snap point. 

L. After you have finished examining the corridor in 3D, right-click the screen and select the 
View Control option again, this time selecting Rotate View from the dropdown as shown 
below. 
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M. Instead of selecting Dynamic from the Rotate View dialog dropdown, this time select the Top 
method instead.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N. Notice the Top perspective view in 3D is the same as a standard 2D view. This can be helpful 
to re-orient yourself after rotating a view in 3D. 

O. Hover your mouse over the Right Edge of Travel or any other linear element that belongs to 
the Y11 corridor.  
 

RIGHT EDGE 
OF TRAVEL 
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P. Next, right-click directly over the Right Edge of Travel (or other linear element) and select the 
Zoom To option from the context menu as shown below. 

 
 

 

 
 
 
 
 
 

 

RIGHT EDGE 
OF TRAVEL 
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Q. Notice that the entire Y11 corridor is now displayed in the View 2, Default-3D window. This is 
due to the intent of the Zoom To tool. When executed, the command zooms to the full 
extents of the corridor that the selected linear element (Right Edge of Travel) belongs to. In 
this instance, that would be corridor Y11. The Zoom To tool can be very helpful, specifically if 
the corridor (CMD) file contains multiple corridors.  

 
Note: The Zoom To command works in both 2D and 3D plan views. 

 
R. You can easily return to the standard View 1, Defaut window at any time by selecting the  

1 View option from the View Control menu. To reiterate, the View Control menu is accessed 
by right-clicking on the screen and holding for a few moments.  
 
 
 
 
 
 
 
 
 
 
 

 

THE ENTIRE CORRIDOR IS  
DISPLAYED AFTER THE ZOOM 

TO COMMAND IS USED  
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S. After selecting the 1 View option from the View Control menu, all windows will close with the 
exception of the View 1, Default window. If the View 1, Default window is not open when the 
1 View option is selected, it will be opened and take focus. 

 
Note: In addition to 2D and 3D plan views, you can also access additional views from the View 
Control menu. Additional views include the Cross-Section, Profile, and Superelvation Views.  

 
14. Model the Y11 Bridge 

A. Click the Browse button (File > Browse) and path to the Module 5 (Initial 
Corridor Modeling) folder and open the R-2635C_RDY_CMD_BRIDGE.dgn file.  

 
Note: All reference files required to model the Y11 Bridge should already be attached.  
 
B. Zoom-in near the Y11 alignment. 
C. Click the New Corridor button (Corridors > Create > New Corridor).  
D. Set the Create Corridor dialog parameters as follows: 

• Feature Definition = Design - A50 (Corridor > NCDOT > Design - A50) 

• Name = Y11-Bridge 
E. The Create Template Drop dialog should load automatically. Set the parameters as follows: 

• Start = 19+35.00 

• End = 22+00.00 

• Drop Interval = 5.0000 

• Template = Y11_TMPLT- Bridge Undivided 1+1 

VIEW 1, 
DEFAULT 

 



 

Module 6 – Initial Corridor Modeling 
 

 
 

Page | 39  
 
 

F. Left click through the prompts and the Y11-Bridge corridor will be created as shown below.  
 

 
 
 

G. Select the Y11-Bridge corridor and hover for a moment. Notice the Corridor tools menu 
displays as shown below. From select the Create Parametric Constraint tool from the menu.  

 

Y11-BRIDGE 
  CORRIDOR 

Y11 
  CORRIDOR 

CREATE 
PARAMETRIC 
CONSTRAINT 
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H. The Create Parametric Constraint dialog will load as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I. Set the following parameters in the Create Parametric Constraint dialog.  

• Start = 19+35.00 

• Stop = 22+00.00 

• Constraint Label = BR_Depth Deck 

• Start Value = -5.000 

• Stop Value = -5.000 
 

J. Now, open the View 2, Default-3D window in addition to the already opened View 1, Default 
window using the 2 Views Plan/3D option like you did previously. 

 
 
 
 
 
 
 
 
 
 
 
 



 

Module 6 – Initial Corridor Modeling 
 

 
 

Page | 41  
 
 

K. Once the View 2, Default-3D window opens, close the View 1, Default, maximize the 
View 2, Default-3D window and toggle off the display of the following reference files 
using the References dialog (Corridors > Primary > References) as shown below.  

 
 
 
 

L. Then zoom in close to the Y11 bridge model and rotate the view like shown below. 
 
 
 
 
 
 
 
 
 
 
 
 

DISPLAY 
TOGGLE 
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M. Next, click the Corridor Objects button (Corridors > Edit > Corridor Objects).  
N. As directed by the prompt, click the Y11 Corridor and the Corridor Objects 

dialog will load. 
O. Click on the Parametric Constraint row and then select the BR_Depth Deck 

constraint at the bottom of the list. The BR_Depth Deck Parametric Constraint 
properties are then displayed to the right. Notice the Enabled box option is checked 
on by default. 

 
P. Unchecking the Enabled option will disable the BR_Depth Deck constraint as shown below. 
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Q. Pay attention to the Y11 bridge model shown in the View 2, Default-3D window and then 
disable the BR_Depth Deck constraint. Watch as the bridge depth reverts back to its default 
depth of 2’. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
R. Finally, re-enable the BR_Depth Deck constraint and notice the bridge depth is restored to 5’. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

BR_DEPTH DECK  
PARAMETRIC  
CONSTRAINT 

DISABLED  
 

BR_DEPTH DECK  
PARAMETRIC  
CONSTRAINT 

ENABLED  
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Y11 SUPERELEVATON 
SECTION 

15. Assign Superelevation to the Y11 Corridor 
A. Click the Browse button (File > Browse) and path to the Module 6 (Initial Corridor 

Modeling) folder and open the R-2635C_RDY_CMD_Y11.dgn file.  
B. Attach the R-2635C_RDY_SUP.dgn to your Corridor (CMD) file using the References  

dialog (Corridors > Primary > References). 
C. Zoom-in near the Y11 corridor and notice that the Y11 Superelevation Section as shown 

below. 
D. Click the Assign To Corridor button (Corridors > Superelevation > Calculate > Assign To 

Corridor).  
E. Follow the Locate First Superelevation Section prompt and select the Y11 

Superelevation Section as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
Hint: If there are several lines and you are uncertain which to choose. Hover over each line for 
a moment and a description will display and this can be helpful. Right-click while hovering 
cycles the display of elements which are on top of each other 

 
F. Right-click (reset) to accept the Y11 Superelevation Section. Then locate the Y11 Corridor as 

prompted. 
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G. After selecting the Y11 Corridor, the Associate Superelevation dialog will be displayed as 
shown below. Superelevation Sections are a special Point Control Type that can be used to 
set template pavement cross slope. The Associate Superelevation dialog is used to assign 
Superelevation Point Controls to a corridor. 

 
 
 
 
 
 
 
 
 
 
 
 

H. Click the OK button and the superelevation will be assigned to the Y11 Corridor. 
I. The Y11 Corridor superelevation point controls can be viewed by loading the Corridor Objects 

dialog (Corridors > Edit > Corridor Objects) and selecting the Point Control row as shown 
below. 

 
J. Following these same steps, apply the Y11 superelevation to the Y11 Bridge Corridor as well. 

For detailed information on superelevation see the NCDOT Superelevation module. 
 
16. Create Dynamic Cross-Sections for the Y11 Corridor 

A. Click the Browse button (File > Browse) and path to the Module 5 (Initial Corridor Modeling) 
folder and open the R-2635C_RDY_CMD_Y11.dgn file.  

B. Click the References button (Corridors > Primary > References) and attach the 
R-2635C_RDY_CMD_BRIDGE.dgn file. 
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C. Zoom-in near the Y11 corridor and notice that the Y11-Bridge corridor is now visible as well. It 
not only visible in the View 1, Default window. It will also be visible in all other views as well, 
including the cross-section view. 

 
 
 
 
 
 
 
 
 
 
 
 
 

D. Next, select the 2 Views Plan/XS option from the  View Control menu. The View Control 
menu is accessed by right clicking within the View 1, Default window and then holding for a 
few moments. This will open the Dynamic Cross Section view.  

 
 
 
 
 
 
 
 
 
 
 
 

Note: You can also access the Dynamic Cross Sections by selecting the clicking the 
Open Cross Section View (Corridors > Review > Dynamic Sections > Open Cross 
Sections).   

Y11-BRIDGE 
CORRIDOR 

Y11 
CORRIDOR 
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E. After selecting the 2 Views Plan/XS option, the View 8, Default window will open beneath 
the View 1, Default window and you will be prompted to Select OK to Create a Dynamic XS 
View. 

 
F. Hit the OK button and you will be prompted to Locate Corridor or Alignment. When given the 

options to Locate Corridor or Alignment when creating Dynamic Cross-Sections please 
consider the following: 

 
Dynamic Cross-Sections based on Alignment 

• Faster to navigate than Corridor based Cross-Sections 

• Interval can be easily adjusted as needed for purposes of review 

• Temporary Dimensioning and some other corridor specific data not available 

• Excellent for quick review, specifically with regards to larger projects  
 
Dynamic Cross-Sections based on Corridor 

• Temporary Dimensioning and other corridor specific data available 

• Interval based on a combination of template drop and design stage 

• Requires more processing, making navigation slower than Alignment based 
Cross-Sections 

• Excellent for detailed review of superelevation, slopes, widths, etc. 
 

VIEW 1, 
DEFAULT 

 

VIEW 8, 
DEFAULT 
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G. Click on the Y11 Alignment in this scenario because you have multiple corridors associated 
with it. This option will create Dynamic Cross Sections for both the Y11 Corridor and the Y11-
Bridge Corridor.  

 
Note: Some cross-section visual attributes and functionality are not available when using the 
alignment method to create dynamic cross-sections.  This will be covered later within the 
module.  

 
H. After selecting the Y11 alignment the Open Cross Sections dialog will open as shown below. 

 
 
 
 
  
 
 
 
 
 
 
 
 

I. Set the Open Cross Sections dialog parameters as follows:  

• Left Offset = 100 

• Right Offset = 100 

• Station = 10+00.00 

• Interval = 10 
 

Hint:  
As you click through the prompts, be aware of the left and right offset parameters.  The 100’ 
offset is dependent on which side of the alignment you click. Notice that the 100 becomes      
-100 when you move your curser to the left side of the alignment. As you move back to the 
right side the parameter becomes 100 again. 
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J. Finally, you will  be prompted to Select or Open View.  Click in the View 8, Default window at 
the bottom of your screen because its already been opened. The Dynamic Cross Sections for 
Y11 will be displayed as shown below. Notice that the View 8, Default window now reads 
View 8, Cross Section instead. 

 
 
17. Navigate the Y11 Dynamic Cross-Sections  

 
A. Notice the View Properties and Stationing menu displayed in the top left corner of the 

View 8, Cross Section window as shown below.  
 
 
 
 
 
 
 
 
 
 

VIEW 8, CROSS 
SECTION 
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B. The arrows shown on either side of the Stationing menu are used to navigate the cross 
sections. Spend a few moments navigating the cross sections using these arrows. 

 
 
 
 
 
 
 
 
 
 
 

C. Each time you click the Navigate Forward or Navigate Back buttons, the stationing increases 
or decreases by an interval of 10. The navigation increment is dependent upon the template 
drop increment. If you were to change the template drop interval to 50’, the navigation 
interval would reflect this change. 

D. As you navigate the Y11 cross sections, a blue line is displayed in the View 1, Default plan 
view as shown below. This line represents the Y11 cross section in the plan view. As you 
navigate the Y11 cross sections in View 8, the blue cross section line moves to the station 
shown in the cross section.  

VIEW 8, CROSS 
SECTION 

 

VIEW 1, 
DEFAULT 

 

BLUE CROSS 
SECTION LINE 

 

NAVIGATE 
FORWARD 

 

NAVIGATE 
TO END 

 
NAVIGATE TO 
BEGINNING  

 

NAVIGATE 
BACK 
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E. Now right click in the View 8, Cross Section view and select the Locate Station Via Datapoint 
option as shown below.  
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

F. Click the View 1, Default window when prompted to Select Plan or Profile View. Notice the 
orange dashed line and its accompanying stationing dialog as shown below. As you move back 
and forth the stationing adjusts accordingly. 
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G. Now, left click near station 21+30 +/- and the corresponding cross-section displays in the 
View 8, Cross section window beneath.  
 

 
 
 
 

H. You also have the option to key-in at specific station in the cross-section view. Click the 
stationing dropdown arrow and key in 19+35.00 and hit the enter button as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 

STATIONING 
DROP DOWN 

 

BLUE CROSS 
SECTION LINE 

 

STATION 
21+31.65 
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I. Station 19+35.00 was the begin bridge station you may recall. Notice the cross-section view at 
this station as shown below. Both the bridge and standard roadway sections are displayed on 
top of one another. This is because the Y11_UF - 1+1 Lanes - LDSS Template Drop and the 
Y11_TMPLT - Bridge Dual Lane Template Drop share this station, which causes this conflict. 

 
 

 
J. This can be resolved by changing the Y11_UF - 1+1 Lanes - LDSS Template Drop end station as 

previously described. Click on the end station and key-in 19+34.99 as shown below.  
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K. This change resolves the conflict between the two (2) conflicting template drops as shown 
below in the cross-section view.  

 

 
L. Resolve the end bridge conflict as well, using the same technique. Changing the Y11_UF - 1+1 

Lanes - LDSS Template Drop begin station from 22+00.00 to 22+00.01. 
 
18. Adjust the Visual Display of the Y11 Dynamic Cross-Sections using the View Properties Dialog  

A. The View Properties menu contains tools that can be used to adjust how the Dynamic Cross 
Sections are displayed. Click the View Properties and a dialog will open as shown below.  
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B. Key-in station 15+60.00 into the stationing dropdown and then change the Vertical 
Exaggeration option in the View Properties dialog from 1.00 to 10.00. Notice that the cross 
sections are now vertically exaggerated as shown below. 
 

 
 
 
 

 
 
 
 
 
 
 

C. Because the Vertical Exaggeration is set to 10.00, it’s easy to see that the cut slopes are not 
actually tying to the existing surface as they should and can be very useful when vertical 
precision is needed. Slopes may not tie properly when a specific station does not match the 
template drop interval.  

 
Note: The slopes can be fixed by selecting the Final design stage. This will be demonstrated 
further along as you continue working through the module. 
 

D. Click on the bottom three (3) View Properties options as shown below and then scroll 
through the Y11 Dynamic Cross-Sections. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CUT SLOPE 
DOES NOT TIE 

 

CUT SLOPE 
DOES NOT TIE 
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E. As you scroll through you will notice that nothing has changed and that the options did not 
take effect.  

F. To resolve this, you will need to re-create the Y11 Dynamic Cross-Sections, only this time 
choosing the Y11-Corridor instead of the Y11 alignment when prompted to Locate Corridor 
or Alignment. For specifics, see the previous steps. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: The bottom three (3) options can only be enabled when the Dynamic Cross-Sections 
are created using a corridor. 

 
G. After recreating the Y11 Dynamic Cross-Sections, re-enable the bottom three (3) options as 

shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

THESE OPTIONS 
REQUIRE DYNAMIC  
CROSS-SECTIONS 
CREATED USING A 

CORRIDOR  
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H. As you begin scrolling through the Y11 Dynamic Cross-Sections notice the additional 
information that is now visible as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: The earthwork data shown below the cross-section itself is for information only and will 
not be displayed in the cross-section sheets.  
 

I. Next, navigate to station 18+60.00 and notice the red flags on either side of the cross-section 
as shown below. These flags are a visual attribute that is only available when the dynamic 
cross-sections are created using the corridor as opposed to the alignment. These flags are 
triggered by the guardrail fill height warrant and are intended to alert the designer that 
guardrail may be necessary. Like the earthwork information these flags are for informational 
purposes only and will not be displayed in the cross-section sheets.  

 

FILL HEIGHT 
WARRANT FLAG 

 

FILL HEIGHT 
WARRANT FLAG 
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J. As you continue scrolling through the Y11 Dynamic Cross-Sections,  notice that the bridge 
cross-sections are skipped.  The bridge sections are not visible because the bridge template 
drop is associated with the Y11 Bridge Corridor and not the Y11 Corridor itself. If you recall, 
there was a break in the Y11 Corridor to accommodate a separate Y11 Bridge Corridor. In 
order to display the bridge limits while in the Y11 Dynamic Cross-Sections, manually key in a 
specific station within the bridge limits or Create Dynamic Cross-Sections using the Y11 
Alignment as opposed to using the corridor itself. 

  
19. Display Temporary Dimensions in the Y11 Dynamic Cross-Sections View 

A. Use the View Properties dialog to eliminate the vertical exaggeration and additional visual 
options that were described in the previous step to revert back to the default presentation as 
shown below. 

B. Next, right click in the View 8, Cross Section view and select the Place Horizontal Temporary 
Dimension option from the context menu as shown below.  
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C. After selecting the Place Horizontal Temporary Dimension option, you will be prompted for a 
Start Point and then an End Point. For the Start Point snap to the ~EOT (left edge of travel) 
point and for the End Point snap to the CL (centerline) point as shown below.  
 

 
D. After snapping to these points, you will then be prompted for a Dimension Height. Move your 

cursor up and down and notice the dimension lines extending from the two (2) dimension 
points move as well.  

E. Adjust this height to your preference and then click the screen to place the temporary 
dimension as shown below. 

 

 
 
 
 

LEFT EDGE 
OF TRAVEL CENTERLINE 



 

Module 6 – Initial Corridor Modeling 
 

 
 

Page | 60  
 
 

F. Next, follow the same process as previously described to label the right cut slope using the 
+GSO_N (right grass shoulder outside normal) point and the +DBF (right ditch base front) 
point as shown below. 

 
 

G. After adding the right cut slope dimension, your cross-section should be displayed as shown 
below. 

 

 
 
 
 
 
 
 
 
 

RIGHT GRASS 
SHOULDER 

RIGHT DITCH 
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H. In addition to Horizontal Temporary Dimensioning, you also have the ability to dimension 
vertical points as well. Vertical dimensioning can be added in the same way. To do so, right 
click in the View 8, Cross Section view and select the Place Vertical Temporary Dimension 
option from the context menu as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I. Next, follow the same process as previously described to label the depth of the left ditch 
using the ~GSO_N (left grass shoulder) point and the ~DBF (left ditch) point as shown below. 

 

LEFT GRASS 
SHOULDER 

LEFT DITCH 
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J. After snapping to these points, you will then be prompted for a Dimension Height. Move your 
cursor left and right and notice the dimension lines extending from the two (2) dimension 
points move as well. 

K. Adjust this height to your preference and then click the screen to place the temporary 
dimension as shown below. 

 
Note: The dimensioning is only temporary and is to be used for information only. Temporary 
dimensioning will not be displayed in the cross-section sheets. For detailed information on 
sheet annotation see the NCDOT Sheeting module 

 
L. Finally, begin scrolling through the Y11 Dynamic Cross-Sections and notice that the 

dimensioning adjusts accordingly.  
 
20. Adjust the Ditch Widths using a Parametric Constraint 

A. Click the Create Parametric Constraint (Corridors > > Edit > Edits > Create Parametric 
Constraint) button. 

B. Select the Y11 Corridor when prompted to Locate Corridor.  
C. Set the following parameters in the Create Parametric Constraint dialog when it loads. 

• Start = 10+00.00  

• Stop = 34+33.17 

• Constraint Label = SS_Width_Ditch 

• Start Value = 15.000 

• Stop Value = 15.000 
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D. Notice that the temporary dimensioning is dynamically updated based on the ditch width 
change as shown below.  

 
 

 
E. To remove the temporary dimensioning, right click in the View 8, Cross Section view and 

select the Remove All Temporary Dimension option from the context menu as shown below. 
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21. Using a Parametric Constraint, add a 125’ Lane Taper at the beginning of the Y11 Corridor 
A. Right click in the View 8, Cross Section view and select the 1 View option from the  View 

Control menu as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. After selecting the 1 View option, the View 8, Cross Section view will be closed and the View 
1, Default view will open. Zoom in near the beginning of the Y11 Corridor as shown below. 

 
C.  Next, click the Corridor Objects button (“The Bucket”) (Corridors > Edit 

> Corridor Objects).  
D. As directed by the prompt, click the Y11 Corridor and the Corridor 

Objects dialog will load. 
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E. Click on the Parametric Constraint row and click Add New button as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F. Once the Create Parametric Constraints dialog loads, set the following parameters and click 
through the prompts shown below. 

• Start = 10+25.00 

• Stop = 11+50.00 

• Constraint Label = LN_Width 

• Start Value = 9.5000 

• Stop Value = 12.0000 
 

 
 
 
 
 
 
 
 
 
 
 
 

ADD NEW 
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G. The LN_Width (pavement width) start and stop values change from 9.5 to 12 over a 125’ 
distance creating a 125’ lane taper, allowing the proposed 12’ lanes to tie back to an existing 
9.5’ lane condition as shown below. 

 
H. Notice that the LN_Width variable is now listed under the Parametric Constraint row of the 

Corridor Objects (“The Bucket”) dialog as shown below. Corridor objects including 
Parametric Constraints can quickly and easily be managed from this dialog.  
 

 
Hint: “The Bucket” could be considered a one-stop shop for corridor management.   
 

I. Following the same steps just described, add an additional parametric constraint to do the 
same for the end of the corridor as well.  

125’ 
TAPER 

9.5’ 

9.5’ 

12’ 

12’ 
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22. Adjust the Y11 Corridor to Display Overlay and Widening of Existing Pavement 
A. Click the Create Template button (Corridors > Create > Template > Create Template) to 

open the Create Template dialog. Then double click on the Y11_UF - 1+1 Lanes - LDSS 

SK_EP_R null point  as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: 
If the NCDOT_Roadway_R-2635C (Training).itl does not open by default, you may need to path to it 
manually.  
 
 
 

SK_EP_R 
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B. Notice the Horizontal Feature Constraint box has been checked and the feature is set to 
Existing Edge of Pavement Right. This means that the +SK_EP_R null point will search for an 
Existing Edge of Pavement Right linear feature. If located, the default horizontal value will be 
overridden by it. 
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C. Change the Horizontal (Constraint 1) value to 5.0000 as shown below and then close out of 
the Point Properties dialog. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

D. Notice that the template subgrade follows the SK_EP_R null point as shown below. This is 
because the subgrade is constrained by the SK_EP_R null point.  

 

SK_EP_R  
NULL POINT 

SUBGRADE IS 
CONSTRAINED 

BY SK_EP_R 
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E. To better demonstrate this child-parent relationship, right-click on the SK_EP_R Null Point 
and select the Test Horizontal Point Control option as shown below. Now as you move your 
curser from side to side notice that the subgrade follows along. The Test Horizontal Point 
Control option simulates how the template will react when an existing edge of pavement line 
is located by the SK_EP_R null point.  

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
Note: The ~SK_EOP null point works the same way, only for the left side.  

 
F. Close out of the Create Template dialog and select the No option when asked if you would 

like to save your changes to the template library.  
 
 
 
 
 
 
 
 

 

SK_EP_R  
NULL POINT 



 

Module 6 – Initial Corridor Modeling 
 

 
 

Page | 71  
 
 

23. Defining Existing EOP Feature Lines for Pavement Wedging and Widening 
A. Open the file R-2635C_RDY_EOP_EXIST.dgn. 
A. Click on the Single Offset Partial command (Geometry > Horizontal > Offsets and Tapers). 
B. Change the Feature Definition to Existing Edge of Pavement Left (Linear > Roadway > Existing > 

Roadway). 
C. When prompted to Locate Element, select the left existing EOP line in the reference FS file. 

 
 

D. Type 0.0000 as the offset value and Enter to lock this value. 
E. Datapoint near the beginning (before) the corridor for the start point. 

 
 
F. The end point should be near the intersection of the proposed EOT. 
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G. Change the Feature Definition to Existing Edge of Pavement Right (Linear > Roadway > Existing > 
Roadway). 

H. When prompted to Locate Element, select the right existing EOP line in the reference FS file. 
I. Type 0.0000 as the offset value and Enter to lock this value. 
J. Datapoint near the beginning (before) the corridor for the start point. 
K. The end point should be near the left existing EOP feature line created in the previous steps. 

 

 
L. Close this file and Open the file R-2635C_RDY_CMD_Y11.dgn. 
M. Next, attach the R-2635C_RDY_EOP_EXIST.dgn to the Y11 Corridor (CMD) file using the 

References dialog (Corridors > Primary > References). 
N. In the View 1-Default window, zoom in closely to the Y11 corridor as shown below 

and notice the two new lines that are now visible. The green line represents the 
existing left-side edge of pavement and the magenta line represents the existing 
right-side edge of pavement.  
 

 
 
 

EXISTING RIGHT-SIDE 
EDGE OF PAVEMENT 

EXISTING LEFT-SIDE 
EDGE OF PAVEMENT 
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O. Hover your mouse over the two (2) edges of pavement to display the element information for 
each as shown below. Pay attention to the Feature attribute of each. Notice that the feature 
names match the Horizontal Feature Constraints of the two (2) SK_EP null point targets. 
 

 
P. Click on one of the Y11 Corridor Object Handles and hover for a few moments to display the 

Corridor Menu. From the Corridor References dropdown select the Add Corridor Reference 
icon as shown below.  

 

EXISTING RIGHT-SIDE 
EDGE OF PAVEMENT 

EXISTING LEFT-SIDE 
EDGE OF PAVEMENT 

CORRIDOR 
REFERENCES 

CORRIDOR 
OBJECT HANDLE 
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Q. Following the prompts, select the four (4) Existing Edge of Travel elements located at the 
beginning and end of the Y11 corridor that are highlighted in turquoise, as shown below. 
Then, reset (right-click) to complete.  

Notes:  

• For the SK_EP null points to target elements, they must first be added as added as 
Corridor Reference elements. See previous steps for specifics on adding Corridor 
References. 

• Corridor Reference data for can be accessed at any time using the “bucket”. 
R. Notice below,  that the corridor re-triangulates after adding the existing edge of travel 

elements to the Y11 corridor as Corridor Reference elements.  
 

 
S. To help visualize the corridor overlay/widening , load the Corridor Menu once again only this 

time select the Open Cross Section Model option from the Corridor View dropdown as 
shown below. This will close the View 1-Default window and open the Y11 Cross section 
view. 

EXISTING EDGE OF 
PAVEMENT ELEMENTS 

EXISTING EDGE OF 
PAVEMENT ELEMENTS 

RE-TRIANGULATED 
CORRIDOR 
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T. As you navigate through the dynamic cross-sections notice the change as displayed below. 
 

 
 
 

U. Right click in the View 8, Cross Section view and select the 1 View option from the View 
Control menu to close out of the dynamic cross-section view and open the View-1-Default 
window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

OPEN CROSS 
SECTION MODEL 

EXISTING EDGE OF 
PAVEMENT  RIGHT 

EXISTING EDGE OF 
PAVEMENT LEFT  
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24. Change the Design Stage Feature Definition from Design - A50 to Final 
A. In the View 1-Default window, zoom in closely to the Y11 corridor and click on one of the 

Corridor Object Handles and hover for a few moments to display the Corridor Menu. From 
the Corridor Menu select the Corridor Properties icon as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
B. From the Corridor Properties dialog, change the Feature Definition from Design - A50 to 

Final as shown below. This will set the Design Stage to Final.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CORRIDOR 
OBJECT 
HANDLE 
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PROPERTIES 
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C. Notice how the Y11 Corridor appears much denser as shown below. This is because the 
Design Stage properites for Final feature create a more detailed and higher quality model.  

D. Now, load the Corridor Menu once again and select the Open Cross Section Model option 
from the Corridor View dropdown as shown below.  

 
 
 
 
 
 
 
 
 
 
 

E. Set the Vertical Exageration to 10 using View Properties dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

OPEN CROSS 
SECTION MODEL 
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F. Then navigate to station 15+60.00 as shown below. Notice that the cut slopes now tie on both 
sides where previously they did not. This is because the Design Stage has been set to Final (5’ 
intervals), there is now a template drop at 15+60.00 which results in a much more accurate 
and higher quality model. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
25. Turn Reference Files and Construction Class Elements off and Display 2D Design Linework  

A. Right click in the View 8, Cross Section view and select the 1 View option from the  View 
Control menu as shown below. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

CUT SLOPES TIE PROPERLY 
AFTER SETTING DESIGN 

STAGE TO FINAL 
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B. Once the View 1, Default window opens, toggle off the display of the following reference files 
using the References dialog (Corridors > Primary > References) as shown below.  

 
 
 
 

C. Finally, select the Toggle Construction Class option from 
the  View Control menu as shown below.  

 
 
 
 
 
 
 
 
 
 
 
 
 

DISPLAY 
TOGGLE 
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D. Notice the 2D linework as shown below. In this workflow, lines used for plans production are 
not drafted in the traditional sense but are displayed directly from the 3D model.  

 

 
Note: Not all plans production linework can be produced using the model. This is only the first step in 
the design/modeling process. More detailed modeling will be necessary as the design progresses. See 
the NCDOT Intermediate and Detailed Modeling modules for specifics. 
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Pop Quiz 
 

1. How does the Corridor Feature Defintion “Design – A50” get its 50’ template drop 
interval? 

 
A. Create the Corridor using 50’ template drop interval only. 
B. Create the Corridor using 5’ template drop interval only. 
C. Create the Corridor using 5’ template drop interval and a multiplier of “10”. 
D. It is automatically set at 50’ interval. 

 
2. What utility is commonly used to define the existing EOP feature definition for the 

templates to display pavement wedging and widening? 
 

A. Microstation Place Line 
B. Microstation Copy Parallel 
C. ORD Line Between Points 
D. ORD Single Offset Partial 

 
3. How are paved shoulder tapers performed in Corridor Modeling? 

 
A. Parametric Constraints 
B. Point Control 
C. Target Feature Definitions 
D. All of the Above 

 
4. Because a 2D design seed was used, the Corridor Modeling (CMD) file contains a 2D 

design model only because we only work in 2D. 
 

A. True 
B. False 

 
5. The EOT, paved shoulder, curb and gutter lines must be drawn in the DSN manually 

like SS2. 
 

A. True 
B. False 

 
 
Answers and explanation on the next page. 
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1. C – The final template drop interval is derived from the Corridor Template Drop interval 
(should always be “5” when creating a corridor) multiplied by a factor (multiplier) set in 
feature definition. 

 
2. D – Unlike Microstation, ORD tools can assign feature definitions. The Single Offset Partial 

utility ensure the creation of the element is traced over the original (offset of zero). This 
command works on both Microstation and Civil Geometry elements. 

 
3. D – All of the listed options can be used to change the paved shoulder width in the template 

and 3D model. 
 

4. B – a Default-3D design model is automatically created and referenced to the Default (2D) 
design model when the existing ground terrain is made active or the vertical alignment is 
made active in the 2D design model. 

 
5. B – The templates in ORD are now setup to automatically generate the tradition 2D DSN plan 

elements, such as the EOT, paved shoulder, and Curb and Gutter lines (and slope stakes), in 
the 2D design model CMD file.  


